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このドキュメント 

• このドキュメントでは，コンピュータシステム部門のアプリケーションプログラム
の仕様を説明します 

• また、SDKの使用方法について解説します． 
 

• 設計コンテストのWEBサイト 
– http://aquila.is.utsunomiya-u.ac.jp/contest/ 

 
• 不明な点は，以下のいずれかの方法でお問い合わせください． 

– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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コンピュータシステム設計部門のターゲット 
「ネットワーク画像オプティカルフロー処理」 

• 目的 
– ホストPCから送られる２つの画像フレーム間の動きベクトルを、オプティカ

ルフロー処理により計算し、画像に書き入れてホストPCに送り返す。 
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概要 

• コンピュータシステム部門では，以下の処理をFPGAボードで行います 
– ホストから2つの入力画像フレーム（32KB x 2）を受け取り、デコードする 

• 画像は独自のJPEGに似た形式で圧縮されたフォーマットで渡されます． 
– 2つのフレーム間のオプティカルフローを計算する 

• オプティカルフローを画像に書き入れる（赤線） 
• 結果画像をエンコードして結果画像フレームにする 

– 結果画像フレーム（max64KB）をホストに送信し、更に”END”（1KB）を送信 
• 注意）UDP・シリアル変換のexStickBridgeは1KB単位でのみパケットを送信 

 
• 参考文献[1] 

– 昌達 慶仁 著，「詳解 画像処理プログラミング」，ソフトバンククリエイティブ
株式会社，2008． 
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FPGA・ホストPC間の通信シーケンス 
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FPGA・ホストPCの処理フロー 
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ホストPCでの前処理内容 

• ２つの入力画像（410_tux0.bmp， 410_tux1.bmp ）をそれぞれYCrCb変換し
，その変換後の画像をJPEG圧縮します． 
– 読み込み可能なBMP画像フォーマットについては，参考文献[1]を参考にし

て下さい 
– YCrCb変換に関しては参考文献[1]にある手法をベースに整数化したバー

ジョンを使用しています．（参考文献[1]では浮動小数点を用いています） 
– YCrCb変換後の画像フォーマットとしては，BMP画像フォーマットのR部分

にY，G部分にCr，B部分にCbを格納して保存しています 
– JPEG圧縮に関しては，参考文献[1]では１要素（RGBならRのみ，今回の場

合Yのみ）に対しての圧縮処理でしたが，YCrCbそれぞれに対して圧縮処
理をするように改良しています． 

– JPEG圧縮では，参考文献[1]では浮動小数点のDCTが使われていました
が，整数化したDCTに変更しました． 

• ２つの入力画像をそれぞれ32KBのサイズに揃えます（0で埋める） 
• ２つをあわせて64KBのデータとし、UDP/IP(8100番ポート)で送信します． 

– 送信したデータは、ToUDP.（画像データ名）.binとして保存されます 
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FPGAでの処理内容 

• FPGAでは以下の処理をします． 
– 32KBの２つのデータを受信 
– ２つのJPEG圧縮画像（img0, img1）をデコード 
– デコードされた画像のそれぞれY, Cr, Cb成分を用いて，オプティカルフロ

ーを求めます． 
– 最初の入力画像（img0）に対してYCrCb->RGB変換（関数名は

convert2bmp）をし，RGB画像を得て，そのRGB画像に対してオプティカル
フローの線を描画します 

– オプティカルフローが描画された画像をJPEG圧縮します 
– 最大64KBの結果画像データを送信し，最後に”END”を送る 
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ホストでの後処理内容 と 時間計測・結果検証 

• FPGAからJPEG圧縮された画像をUDP/IP経由で受け取り，ファイルに保存し
ます．ファイル名：FromUDP.(画像データ名).binとして保存します． 

• 上記ファイルをデコードし，RESULT.(画像データ名).bmpとして保存します． 
• 正しいデータと一致しているか確認します． 

 
• 競技の時間計測について 

– ホストPCにおいて、以下のT2-T1の経過時間を計測します 
• T1: UDPにて64KBの画像データを送信 
• T2: UDPにて”END”を受信 

– その後、BMP画像データが、リファレンスデザインの結果BMP画像データと
完全一致しているかを検証します 
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コンピュータシステム設計部門 
リファレンスデザインSDKの 
使用方法 

• コンテストWEBサイトから、コンピュータシステム設計部門のリファレ
ンスデザインSDK（400_oflow_v10.tgz）をダウンロードして展開。 

• 開発環境： LinuxもしくはCygwin 
• http://aquila.is.utsunomiya-u.ac.jp/contest/toolkit.html 
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SDKの使い方 (1) ディレクトリ構成 

• ディレクトリ構成の簡単な説明です． 
– common : 共通ソースファイル 
– xilinx : Xilinx用ソースファイル 
– altera : Altera用ソースファイル 
– linux  : Linux用ソースファイル 
– client : ホスト用クライアントプログラムのディレクトリ 
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主なソースファイルの構成 

ディレクトリ ファイル名 概要 

Platform 
(linux, 
xilinx, 
altera) 

addressmap.h 
addressmap.c 

アドレスマップ 

communication.h 
communication.c 

ホストとの通信 

platform.h 
platform.c 

プラットフォーム固有の処理 

bmp.h, bmp.c ビットマップファイル関連(linuxのみ) 

Common codec.h 
codec.c 

Codecその他画像の変換関連のライ
ブラリ 

fileio.h 
fileio.c 

メモリファイル入出力 
（stdioのFILE置き換え） 

image.h, image.c 画像関連ライブラリ 

main.c メイン 

oflow.h, oflow.c オプティカルフロー関連処理 
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ユーティリティツール一覧 

ディレクトリ ファイル名 概要 

Linux decoder.c デコーダ 

encoder.c エンコーダ 

make32KBdata.c 32KBデータ作成 

rgb2ycbcr.c RGB→YCrCb色変換 
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SDKの使い方 (2) Linuxプログラムの動作確認-１ 

• FPGAボードが無くても，リファレンスデザインの機能を確認することが出来ます 
• トップディレクトリでのmake コマンドにより，FPGAボードでの動作を模擬する

Linux上で動作するプログラムを作成することが出来ます． 
 

• 出来上がる主なファイルは次の通りです． 
– 400_oflow      : Linux用のオプティカルフロー処理プログラム 
– encoder        : BMPファイルのJPEG風エンコーダ 
– decoder        : BMPファイルのJPEG風デコーダ 
– rgb2ycbcr      : BMPファイルの色変換(RGB -> YCrCb) 

• トップディレクトリで，以下のコマンドにより400_oflowプログラムを起動します． 
 

• 以下の様に、ホストプログラムからの画像データを待ち受ける状態になります． 
– UDP/8100ポートにて32KBバイトの画像データ２セットを待ち受けます． 
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$ ./400_oflow 
Starting 400_oflow (batchID:410) === 
Waiting recv 32KB at 0906c008 

$ make 

$ ./400_oflow 
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SDKの使い方 (2) Linuxプログラムの動作確認-２ 

• 次に，別ウィンドウを開き，以下のコマンドでホストプログラムを起動します． 
 
 

• all.shは画像データセットを送るスクリプトを４つ順次起動します． 
– (410_tux.sh, 411_anim.sh, 412_star.sh, 413_rectangle.sh) 
– この際，スクリプトの内部では，javaのUDP送信プログラムを起動します． 
– all.shスクリプトの引数には，UDPパケットの送信先IPアドレスを指定可能 

 

15 

$ ./all.sh 
targetHost:127.0.0.1 targetPort:8100 
UDP Socket created. sending file '410_tux.64KB' 
started! 
64KB sent 
 
finished! 
after-before = 3331318965 (ns) = 3.331318965(s) 
（続く） 

$ cd client 
$ ./all.sh 
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SDKの使い方 (2) Linuxプログラムの動作確認-３ 

• 正しく動くと、4回のオプティカルフロー計算処理が走ります。 
• 結果は、ホストPC側（クライアント側）にRESULT.***.bmpファイルとして保存さ

れます。 
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SDKの使い方 (3) Xilinx/Altera FPGAボード向け 
ソースファイルのexport方法 

• FPGAボード上で動作するソフトウェアのソースファイルをexportするには，以
下の様にします。 
 
 

• exportディレクトリ以下に、xilinx/srcディレクトリとaltera/srcディレクトリが出
来ますので、その中の.cファイル・.hファイルを，Xilinx MicroBlaze環境もしく
はAltera Nios2環境にコピーして使用してください。 
 

• 以降は，別ドキュメントにて，Xilinx/Altera環境での動作方法について説明し
ます． 
– P61 Xilinx環境 
– P62 Altera環境 
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$ make export 
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SDKの使い方 (4) 既知の問題 

• 現在のリファレンスデザインには，以下に挙げる問題があることが分かっていま
す．注意してお使いください． 
– 元画像(BMP)をエンコードし，デコードすると元画像に戻らない場合がある

．（特に画像サイズが大きい場合） 
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改訂履歴 

• Ver.2014-06-26 
– コンピュータシステム設計部門のリファレンスデザイン(Xilinx,Altera)公開 

• Ver.2014-06-06 
– 初版 （第1回コンテストの内容に追加変更をした） 
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第２回 ARC/CPSY/RECONF 高性能コンピュータシステム設計コンテスト 

The 2nd ARC/CPSY/RECONF  
High-Performance Computer System Design Contest 

User Manual of Optical Flow System 
Reference Design (Xilinx ATLYS) 

コンテスト実行委員会コアチーム 
Version 2014-06-26 
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このドキュメント 

• このドキュメントでは，Atlysボード用のリファレンスデザインに含まれるシステ
ム構成について説明します． 

• また，Xilinx Platform Studio (ISE14.7)を用いて，リファレンスデザインの回
路ファイル（bitファイル）を生成し、プログラムしたFPGA上で400_oflowソフト
ウェアを動作させる方法を示します． 

 
• 設計コンテストのWEBサイト 

– http://aquila.is.utsunomiya-u.ac.jp/contest/ 
 

• 不明な点は，以下のいずれかの方法でお問い合わせください． 
– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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最初に 

• Xilinx版とAltera版は機能的には同じですが，異なる所が多々ありますので，
注意して下さい． 

• Xilinx版のリファレンスデザインは，ISE14.7のEDK Xilinx Platform Studio
で開発できます．ISE WEB Packでは開発できませんのでご注意ください． 

• 大学関係者であればXilinx University ProgramのISEライセンス申請が可能
です． 
– http://japan.xilinx.com/support/university.html 

• またISEの無償評価版ライセンスがXilinxのホームページより申請可能です． 
– http://japan.xilinx.com/ise_eval/index.htm 

http://japan.xilinx.com/support/university.html
http://japan.xilinx.com/ise_eval/index.htm
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リファレンスデザインAtlys-oflowのブロック図 
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システム構成の概要 

• 本システムの構成は、Digilent社のWEBサイトにて提供されている，”Atlys 
board support files for EDK BSB wizard”を用いて作製しました． 
– http://www.digilentinc.com/ 

 
• 構成要素 

– MicroBlazeソフトコアプロセッサ 
• 設定）浮動小数点なし，32ビット乗算器搭載，I$8KB，D$8KB 

– Block RAM (BRAM) 32KB 
– SDRAM I/F (128MB) 
– MicroBlaze Debug Module (MDM) – JTAGによるデバッグ接続 
– RS232C_Uart  

• AtlysボードのUART-USB変換用のシリアル通信（115.2Kbps） 
– Axi_ploader_uart 

• 本コンテスト用のシリアル通信(1Mbps)  
→ PMODコネクタ経由でexStickBridgeに接続 
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メモリマップ 

メモリアドレス 
開始アドレス 終了アドレス 

0x0000_0000 0x0000_7FFF Block RAM (on-chip) 
0x4060_0000 0x4060_FFFF RS232_Uart  

(115.2kbps USB-UART) 
0x77A0_0000 0x77A0_FFFF Axi_ploader_uart 

(1Mbps UART via PMOD) 
0xA800_0000 0xAFFF_FFFF SDRAM (128MB) 
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コンピュータシステム設計部門 
ATLYSボード用ハードウェアリファ
レンスデザインの使用方法 

• コンテストWEBサイトから、コンピュータシステム設計部門のXilinx 
FPGA – Atlysボード用のリファレンスデザイン 
Atlys-oflow_v02.zipをダウンロードして展開します。 
• 展開先例） C:¥workspace-edk147¥Atlys-oflow 
• http://aquila.is.utsunomiya-u.ac.jp/contest/toolkit.html 
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ハードウェアセットアップ 

• Windows 7 マシン と Atlysボード を２本の USBケーブル で接続 
• FPGAボード用電源 を使ってAtlysボードに電源供給 
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USBケーブルで接続 
FPGAコンフィギュレーション用 

USBケーブルで接続 
シリアル通信用 （115.2Kbaud） 

FPGAボード用電源 

Atlysボード 

Windows 7 マシン 

• 注意点 
– AtlysボードにはUSBケーブルが１本しか添付されていません．別途 1本のUSBケーブル

（Aコネクタ-マイクロBコネクタ）を準備してください． 
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準備 USB-UARTドライバのインストール 

• Windows 7 マシンにUSB-UARTドライバをインストール 
– http://www.exar.com/connectivity/uart-and-bridging-

solutions/usb-uarts/xr21v1410 
• Software Drivers Windows 2000, XP, Vista, 7, and 8 Drivers 

Version 2.0.0.0 August 2013 
 

 

29 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

ソフトウェアセットアップ Tera Term のインストール 

• Windows 7 マシンに Tera Termをインストール 
– http://sourceforge.jp/projects/ttssh2/ 
–  teraterm-4.78.exe 
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Tera Term の設定 （１） 

• ATLYSをコンピュータに接続し，COMポートが見えることを確認 
– Windows の デバイス マネージャー から確認 
– ポート番号(COM5)はコンピュータによって異なります． 

 
 
 

 
• Tera Term を立ち上げる（シリアル ポートを選択） 
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Tera Term の設定 （２） 

• Tera Termのシリアル設定を 115.2Kbaud に変更します． 
– 設定 -> シリアルポート -> ボー・レート 

115200を選択して， OK をクリック． 
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Xilinx Platform Studio (XPS)の起動とExport 

• ISE Desugin Suite 14.7 → EDK → Xilinx Platform Studioを起動
し、Atlys-oflow/system.xmpを開く 
– 以下、C:¥workspace-edk147¥Atlys-oflowに配置したとする 

• 以下の画面になるので、”Export Design”をクリック 
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Export to SDK, XSDKの起動 

← Export & Launch SDKをクリック 
＜HDL生成・合成・配置配線・ビットス
トリーム生成に約20分程度かかる＞ 
↓その後、以下の画面が出るので、 
プロジェクトディレクトリの下の、
”SDK/SDK_Export”ディレクトリを指
定する。 
例） C:¥workspace-edk147¥Atlys-
oflow¥SDK¥SDK_Export 
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Xilinx SDKの起動 

• 以下のような画面が現れるはず 
• 次ページ以降は、リファレンスデザインのSDK(400_oflow_v02.tgz)

からexportした.c, .hファイルを用いてアプリケーションを作成する方法
を説明する。 
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アプリケーションプロジェクトの作成 (1/3) 

• メニューFile→New..から、Application Projectを選択 
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アプリケーションプロジェクトの作成 (2/3) 

• プロジェクト名を設定（例：400_oflow） 
– Nextをクリック 

• 次の画面で、Empty Projectを選択 
– Finishをクリック 
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アプリケーションプロジェクトの作成 (3/3) 

• SDK(400_oflow_v02.tgz)からexportした.c, .hファイルをコピー(Ctrl+C) 
• XSDKの400_oflowプロジェクトのsrcディレクトリをクリックした後に、ペースト

(Ctrl+V) 
– Drag&DropでもOK 

• 自動的にビルドが始まる 
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JTAGケーブル設定＆FPGAプログラム 

• ①JTAGの設定をします。右のWindowが出るのでDigilentを選択 
• ②Program FPGAして下さい。 

– 次のWindowでProgramをクリック 
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デバッグ用シリアルコンソールの接続(TeraTerm) 

• プログラム実行前にTera Termにて、シリアルコンソールを立ち上げておきま
す。 
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プログラムの実行 

• プロジェクトを右クリックし 
• Run Asのメニューを選び 
• Launch on Hardware  

(GDB)をクリックしてください 
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400_oflowの起動 

• Starting 400_oflow・・・という 
起動メッセージが表示されるはず 
– 表示されない場合は 

ここまでの作業を再確認 
• 32KB＋32KBの画像データを 

UDP/8100番ポートで 
待ち受けています 
（exStickBridge経由） 
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ホストPCでのUDP通信プログラムの起動 

• ホストPCにて、画像データを用意し、UDPによりFPGAに転送する必要がありま
す。 

• リファレンスデザインのSDK(400_oflow_v02.tgz)を、ホストPCに展開し、
clientディレクトリにて、all.shスクリプトを動かします。（IPアドレスを指定） 

new UDP_Client 
(“imageset1.64KB”) 

.run() 

FPGA ホストPC 
imageset1.64KB 

nextFrame() 
“END”(1KB) 

decode() decode() 
oflow1 (max64KB) optical_flow() 

encode() 

$ ./all.sh 192.168.10.64 
targetHost:192.168.10.64 targetPort:8100 
UDP Socket created. sending file '410_tux.64KB' 
started! 
64KB sent 
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スタック領域の設定 (1/2) 

• しかし、最初の画像を読み込んだ後、止まってしまうかもしれません。 
– XSDKのデフォルトでは、スタック領域が1KB(0x400)バイトしかありません

ので、上手く動きません。 
• スタック領域の大きさを設定するには、 

プロジェクトを右クリックして、Generate Linker Script 
を選択します 
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スタック領域の設定 (2/2) 

• Generate Linker Scirptダイアログで、例えば以下の設定をします。 
– CodeSectionの配置: DDR2 
– DataSectionの配置：DDR2 
– Heap&Stackの配置：bram 
– HeapSize: 1 KB 
– StackSize: 16 KB 

• その後、Generateすると 
Overwriteするか聞かれる 
のでlscript.ldファイルを 
更新します。 
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400_oflowの動作確認 

• さて、動くでしょうか・・・？400_oflowプロジェクトを右クリックして、Runします 
• ホストPC用のクライアントも再度動かしてください。($ ./all.sh 192.168.10.64) 
• Linux上で動作させたときと同じ様にRESULTのBMPファイルが出来ればOK！ 

46 

それではいよいよ高速化に挑戦する開発を始めましょう！！ 
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このドキュメント 

• このドキュメントでは，Altera DE2-115ボード用のリファレンスデザインに含ま
れるシステム構成について説明します． 

• また，Altera Quartusを用いて，リファレンスデザインの回路ファイル（sofファ
イル）を生成する方法を示します． 

 
• 設計コンテストのWEBサイト 

– http://aquila.is.utsunomiya-u.ac.jp/contest/ 
 

• 不明な点は，以下のいずれかの方法でお問い合わせください． 
– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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最初に 

• Altera版ContestSysはXilinx版と機能的には同じですが，異なる所が多々あ
りますので，注意して下さい． 

• Altera版のリファレンスデザインは，Quartus Web Editionで開発できるよう
に考慮しております．そのため，Nios2の実装にはNios2/eを使用し，キャッシ
ュ等は搭載しておりません． 

• 大学関係者の方はAcademic License（無料）がAlteraのホームページより申

請可能ですので，利用される事をお勧め致します．以下，簡単に手順方法を記
載しておきます． 
1. AlteraのUniversity Program（

http://www.altera.com/education/univ/unv-index.html）のページの
左にあるメニューの中の，Member->License Requestをクリックする 

2. myAlteraのアカウント名，パスワードを入力して，申請ページへ行く． 
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リファレンスデザインContestSysのブロック図 

Contest 
UART 

Nios II/e On-chip 
Memory 
(256kB) 

SDRAM 
Interface 

PLL 

nios2_sys 

ContestSys 

SDRAM 
(128MB) 

UART 

JTAG 
UART 

USB Blaster 

exStickBridge 

UDP/IP 
(100M ethernet) 
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各機能の役割 

• PLL 
– 50MHzのクロックを供給 

• On-chip Memory（256kB） 
– 命令メモリとして使用 

• SDRAM 
– NiosIIの命令メモリ，データメモリとして使用． 

• Contest UART 
– データ転送用のインターフェース． 
– UARTから受信したデータを32ビットのデータとして格納する． 
– 8ビットのデータをUART経由で送信する 

• JTAG UART 
– NiosIIでの実行経過などをprintfで出力するインターフェース 

• NiosII/e 
– オプティカルフローを計算するCPU 
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Contest UARTの詳細 
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Contest UART 
 avalon interface 

avalon bus 

UART RX to char 
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Contest UARTの詳細 

• contest UART avalon interface 
– UART RXやUART TXに対してavalonバスとのinterfaceになる 

• char to int 
– UART RXを8ビットのデータにしたものを32ビットのデータに変換する 

• UART RX to char 
– シリアルで入力されるUART RXのデータを8ビットのデータに変換する 

• UART TX 
– 8ビットのデータをシリアルで送信する 
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メモリマップ 

メモリアドレス 
開始アドレス 終了アドレス 

0x0000_0000 0x0003_FFFF on-chip memory 
0x0004_1020 0x0004_102f Contest UART 
0x0005_0000 0x0005_07FF Nios II/e 
0x0800_0000 0x0FFF_FFFF SDRAM 

補足 
• SDRAMの領域は0x0800_0000番地から使用出来るのですが， 

リファレンスデザインでは0x0c00_0000番地から使用しています． 
（SDRAM領域の0x0800_0000番地からの領域をデバッグに用いていたため） 
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リファレンスデザインの作成について 

• 次ページ以降で作成するリファレンスデザインの作成方法では，Verilog-HDL
の記述は既に完成しているものを使用するとします． 

• 本ドキュメントで参照するファイルは以下のものです． 
– ContestSys05.tar.gz 

• DE2-115ボード用コンピュータシステム設計部門リファレンスデザインのプロジ
ェクトファイル 

– DE2-115.qsf 
• DE2-115ボード用ピン設定ファイル．下記のURLから取得できます 

http://www.altera.com/education/univ/materials/boards/de2-115/unv-
de2-115-board.html 
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新規プロジェクトの作成 

1. プロジェクトを置くディレクトリは新規に空のディレクトリを作成する．ここでは
ContestSys06とします 

2. 新規に作成したディレクトリでQuartus を起動する 
3. File -> New Project Wizardを選択 

1. プロジェクト名をトップモジュール名（ContestSys）にする（次ページ左写真）． 
その後Next 

2. Add fileでは何も追加しない 
3. デバイス名はCyclone IV E EP4CE115F29C7を選ぶ（次ページ右写真） 
4. EDA toolの設定でSimulationツールとしてModelsimを選んでいる場合は

FormatをVerilog HDLにする 
5. その他はデフォルトでNextを押し，finishまでいく 
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新規プロジェクトの作成 
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Name filterでデバイス名の候補を 
filteringできる 
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Qsysの起動と外部クロックの設定 

• ここではQsysのシステムとしてnios2 sysを作成します． 
• Tools -> QsysでQsysを起動する 

（以下Qsysでの操作です．） 
• File -> Save でnios2_sysという名前をつけて保存 
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PLLの追加 

• Library から PLL -> Avalon PLL を選択し，Add 
• 現れたWindowで以下を設定 

– Parameter Setting -> General/Mode内の入力クロックを50MHzに設定 
（次ページの画面1） 

– Output Clock -> clk c0のEnter output clock frequencyのラジオボタン
を選択し，50MHzと入力（次ページの画面2） 

– Output Clock -> clk c1のEnter output clock frequencyのラジオボタン
を選択し，50MHzと入力し，Clock phase shiftを-3nsとする．（2ページ先
の画面3） 

– Finishボタンを押す 
• 追加したPLLの名前をpllに変更 
• PLLの配線を以下の用にする 

– pllのclk_in_primaryとclk_0のclkを接続 
– pllのclk_in_primary_resetとclk_0のclk_resetを接続 

• PLLのc1をexport欄をダブルクリックしてexportし，export名をsdram_clkと
する 

• PLLのlocked_conduitのexport欄をダブルクリックしてexportし，export名を
lockedとする（2ページ先の画面4） 
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PLLの追加 
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画面1 

ここの欄が現在設定している 
項目を示すタブになっている 

画面2 
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PLLの追加 
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画面3 

画面4 
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PLLの設定 

• 追加したPLLの名前をpllに変更 
• PLLの配線を以下の用にする 

– pllのclk_in_primaryとclk_0のclkを接続 
– pllのclk_in_primary_resetとclk_0のclk_resetを接続 

• PLLのc1をexport欄をダブルクリックしてexportし，export名をsdram_clkと
する 

• PLLのlocked_conduitのexport欄をダブルクリックしてexportし，export名を
lockedとする 
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SDRAM Controllerの追加 

• Library から Memories and Memory Controllers->External Memory 
Interfaces-> SDRAM Interfaces -> SDRAM Controllerを選択し，Add 

• 現れたWindowで以下を設定する 
– Data Width: 32 
– Address Width 

• Row: 13，Colum: 10 
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SDRAM ControllerのTiming設定 

• Timingタブをクリック 
– Issue one refresh command every を7.8125us 
– Delay after powerupを200us 

• Finishボタンをクリック 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

SDRAM Controllerのclk配線など 

• 追加したsdram controllerの名前をsdramに変更（
new_sdram_controller_0という名前の上で右クリックを押して現れるメニュー
からRenameを選択） 

• pllのc0をsdram controllerのclkに配線 
• clk_0のclk_resetをsdramのresetに配線 
• sdramのwireをExportするようにExport欄をダブルクリック．（Export名を 

sdram_wireとする） 
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On-Chip memoryの追加 

• Library から Memories and Memory Controllers-> On-Chip -> On-Chip 
Memory(RAM or ROM)を選択し，Add 
– Total Memory Sizeを262144とする(256k) 
– Finishをクリックする 

• 名前をonchip_memoryに変更 
• onchip_memoryのclk1をpllのc0と接続する 
• onchip_memoryのreset1をclk_0のclk_resetと接続する 
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JTAG UARTの追加 

• Library から Interface Protocols-> Serial -> JTAG UARTを選択し，Add 
– Finishをクリックする 

• 名前をjtag_uartに変更 
• jtag_uartのclkをpllのc0と接続する 
• jtag_uartのresetをclk_0のclk_resetと接続する 
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contest uart avalon interfaceをComponentとして登録 

• ProjectのNew Componentを選択して，Add 
• Component Typeタブ内 

– Name, Display Nameを”contest_uart_avalon_interface”とする 
– Groupを”My Own IP Core”とする 

• Filesタブ内 
– （プロジェクトディレクトリ内にリファレンスデザインのプロジェクトディレクトリ

にある以下のファイルをコピーしておく 
• contest_uart_avalon_interface.v 
• system.v 
• define.v 

– Synthesis Filesとして，define.v以外の上記2つのVerilog HDLファイル
を追加する（contest_uart_avalon_interface.vがTop-level Fileとなって
いるのを確認） 

– Analyze Synthesis Filesボタンをクリック 
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contest uart avalon interfaceをComponentとして登録 

• Signalsタブ内 
– clockのinterfaceの所を選択して，new Clock Inputを選択し，interface

欄がclock_sinkとなるようにし，Signal Typeをclkとする 
– resetのinterfaceの所を選択して，new Reset Inputを選択し，

interface欄がreset_sinkとなるようにする． 
• Interfaceタブ内 

– Remove Interfaces With No Signalsボタンを押す 
– s1のAssociated Clockをclock_sinkに，Associated Resetをreset_sink

にする 
– conduit_end_0のAssociated Clock, Associated Resetも同様にする 
– reset_sinkのAssociated Clockをclock_sinkにする 

• Finishボタンを押し，保存するかどうかを訪ねるWindowが出たら，Saveを選ぶ
． 
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contest uart avalon interfaceを追加 

• ProjectのMy Own IP Core内のcontest_uart_avalon_interfaceを選択して
Add 
– Finishボタンをクリック 

• 名前をcontest_uartに変更 
• contest_uart_avalon_interfaceのclock_sinkをpllのc0と接続 
• contest_uart_avalon_interfaceのreset_sinkをclk_0のclk_resetと接続 
• contest_uart_avalon_interfaceのconduit_end_0のexport欄をダブルクリ

ックして，export名をexportとする 
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Nios II/eの追加 

• Library から Embedded Processors-> Nios II Processorを選択し，Add 
– Nios II CoreとしてNios II/eを選択する 
– Finishをクリックする 

• 名前をnios2に変更 
• nios2のclkをpllのc0と接続する 
• nios2のreset_nをclk_0のclk_resetと接続する 
• nios2のdata_masterをcontest_uartのs1，jtag_uartのavalon_jtag_slave

，onchip_memoryのs1，sdramのs1と接続する 
• nios2のinstruction_masterをonchip_memoryのs1，sdramのs1と接続する 
• nios2のIRQとjtag_uartのIRQを接続する 
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NiosII/eの追加 
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nios2の設定 

• nios2を選択して，右クリックし，Editを選択する 
• Reset vector memoryとException vector memoryとして，

onchip_memory.s1を選択する 
• Finishボタンをクリック 
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メモリマップの作成 

• メモリマップとしてbase addressを以下のように指定して，ロック 
– sdramのmemory: 0x0800_0000  
– onchip_memory:0x0000_0000 
– contest_uart: 0x0004_1020 
– nios2: 0x0005_0000 

• jtag_uartはどこに割り当ててもよいので，System->Assign Base Addressで
割り当てる  
 

ロックを外した状態で 
アドレスを入力し， 
その後ロックをかける 
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nios2_sysの生成 

• メニューSystem -> Create Global Reset Networkをクリック 
• この時点で，Qsys下部のMessageからエラー表示がなくなっているはず 
• mips_sysを保存 
• メニューGenerate -> Generateをクリック 

– Generateボタンをクリック 
• ちなみに，mips_avalon_interface.vなどを変更する度に，QsysでGenerate

する必要があります 
• 以上で，Qsysは終了してOK 

Generateでは 
右下のGenerateボタンを 
押すだけでよい 
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プロジェクトへのファイルの追加 

• あらかじめ，ContestSys.vをプロジエクトディレクトリにコピーしておく 
• Porject -> Add/Remove files in Projectで以下のファイルを追加する 

– ContestSys.v 
– nios2_sys.qsys 

• 追加したらOKボタンを押してウィンドウを閉じる 

ここをクリックして追加するファイルを選択し，その後addボタンを押す 
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ピン配置情報のimportと割当 

• Assignments -> Import Assignmentsをクリック 
– DE2_115.qsfを選択し，importする 

• Assignments -> Pin Plannerをクリック 
– 現れるウィンドウの下の方にある各ピンの設定で，GPIO[3]のI/O 

Standardを3.3V LVCMOSにする 
– 同様に GPIO[5], GPIO[7], GPIO[9]も同様に変更する 
– メニューFile -> closeをクリックして，ウィンドウを閉じる 

Node Name Location I/O Standard 

GPIO[3] PIN_Y17 3.3V LVCMOS 
GPIO[5] PIN_Y16 3.3V LVCMOS 
GPIO[7] PIN_AE16 3.3V LVCMOS 
GPIO[9] PIN_AE15 3.3V LVCMOS 
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ピン配置情報のimportと割当 
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構成情報の生成 

• Processing -> Start Compilationをクリックして，論理合成＆配置配線 
• DE2-115ボードの電源をいれる． 
• Taskウィンドウ内のProgram Device( Open Programmer)をダブルクリック 
• Programmer内にて，Hardware Setupボタンをクリック． 

– No Hardwareとなっている所をUSB-Blaster USBを選択して，closeボタ
ンをクリック 

• Start ボタンを押して，Progress が100%(Successful）になればOK 
• Programmerを閉じる 
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ソフトウェアデザイン 
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Workspaceの設定 

• ハードウェアのプロジェクトディレクトリの下にsoftwareというディレクトリを作る
．（例：ContestSys05/software） 

• QuartusのメニューTools->Nios II Software Build Tools for Eclipseを選
択する 

• EclipseのメニューFile -> Switch Workspace -> Otherを選択し，上記で作成
したContestSys05/softwareを選択する．（初めてEclipseを立ち上げた場合
は，いきなりWorkspaceの選択から入るかもしれない） 
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新規プロジェクトの作成 

• File -> New -> Nios II 
Application and BSP from 
Templateを選択 

• Target hardware informationの
SOPC Information File nameに
は，Quartusのプロジェクトディレク
トリにあるnios2_sys.sopcinfoを選
択する 

• Project nameを「400oflow」とす
る 

• Project templateにはBlank 
Projectを選ぶ 

• 以上で，Finishボタンを押す 
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BSPの設定 

• 400oflow_bspを選択した状態で，右クリックし現れるメニューで， 
Nios II -> BSP Editorを選択 

• 現れるWindowの中のLinker Scriptを選択し，”.bss”, “. heap”, などを全て
onchip_memoryに置くように設定する 

• Nios II BSP EditorのFile メニューの中からSaveを選択する 
• Generateボタンを押し，Exitボタンを押す 

84 

BSPを保存するときの 
Fileメニュー 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

BSPのBuild 

• 400oflow_bspを選択した状態で，右クリックし現れるメニューで， 
Build Projectをクリック 

• Consoleにて，”[BSP build complete]”が出力されている事を確認 
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400oflowのBuild 

• ファイルの準備 
– コンテストのサイトから配布されている400oflow_v07.tar.gzを展開し，

400_oflowディレクトリに移動し，そこでmake exportをする． 
– 上記により，export/altera/src/の下にnios用のソースファイルが生成さ

れる 
– software/400oflowディレクトリに移動し，export/altera/srcディレクト

リにあるファイルを全てコピーする． 
• Eclipse上で，400oflowプロジエクトを選択した状態で，右クリックし現れるメニ

ューで， 
– Refreshをクリックする 
– Build projectをクリックする  
– Run As -> Nios II Hardwareをクリックする 

• 後はホストPCから画像の転送プログラムなどを動かせばOK 
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